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HY-8 Quick Start Guide 
This Quick Start guide is intended to provide essential information for installing and running the 
new Windows based version of the HY-8 culvert hydraulic analysis and design program.  

What’s in this Quick Start Document 
This document includes information about downloading and installation of the program, some 
important differences between the older DOS version and this new Windows version, a simple 
tutorial problem to introduce you to the basic operation of HY-8, and ways to report bugs or 
other problems.  

Technical Methods 
HY-8 is a computerized implementation of FHWA culvert hydraulic approaches and protocols. 
The initial HY-8 program was first released in the early 1980’s, however; FHWA has been 
producing computerized culvert hydraulic software since the early 1960’s (with the HY-1 
program).  

The FHWA publication “Hydraulic Design Series 5: Hydraulic Design of Highway Culverts” 
(HDS-5) [publication FHWA-NHI-01-020, May 2005 revision] documents the technical methods 
applied in the HY-8 program and should be considered the primary technical reference for the 
software.  

The HY-8 installation file includes the HDS-5 document as a portable document format (PDF) 
file. HDS-5 is also accessible from the HY-8 program Help menu. A hard copy of HDS-5 can be 
created by printing the PDF file.  

For these reasons, FHWA certifies that this version of HY-8 continues to represent reviewed, 
tested, and accepted software for the purposes of performing FHWA culvert analyses regulated 
under 23 CFR 650 Subpart A and meeting 44 CFR 65.6(a)(6) in the FEMA NFIP regulations.  

Downloading 
The installation package (SETUP.ZIP) can be obtained by downloading from the FHWA 
Hydraulic website at: http://www.fhwa.dot.gov/engineering/hydraulics/software/hy8.  

As stated in the FHWA Hydraulics website, by downloading the software, the user is agreeing 
that they accept responsibility for understanding the following conditions and limitations, and 
agrees to them: 

 FHWA does not provide user assistance or support for this software.  

 The application of this software is the responsibility of the user. It is imperative that the 
responsible engineer understands the potential accuracy limitations of the program results, 
independently cross checks those results with other methods, and examines the 
reasonableness of the results with engineering knowledge and experience.  

 There are no expressed or implied warranties. 
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Prior to Installation 
Older versions of the HY-8 program should be removed from your system before trying to install 
an update. This is done by going to the Windows Control Panel and using the Add/Remove 
programs command. When doing so, project files you have created will not be deleted. After 
removing the older HY-8 version, you can install a new version.  

Installation1 
Once downloaded to your computer, open the SETUP.ZIP file and extract three files (Setup.exe, 
Setup.msi, and vcredist_x86.exe) into a temporary or other folder. The last file – 
vcredist_x86.exe – MUST be placed in a sub-folder called “vcredist_x86” (as seen below).  

 
 

Begin the installation of HY-8 by double-clicking (opening) the SETUP.EXE program.  

You may get a screen such as:  

 
                                                 
1 Depending on the operating system, HY8 installation may require access to Administrator rights. Should this be 
the case, contact your system or network administrator for assistance.  
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FHWA is the Publisher of HY-8. Select “Run” to continue installation.  

Accepting Terms and Conditions 
During the installation, the user is once again asked to review and accept the Terms and 
Conditions for using the HY-8 software.  

Failure to accept these terms will result in non-installation of the program.  

Default Program Location 
The default location for program installation is folder: “C:\Program Files\FHWA\HY-8”. 

However, a user can change the location to any directory without affecting the performance of 
the program. Use the Browse option to select an alternative (or new) folder.  

Accessing the HY-8 program file  
The Setup program will place a shortcut to the HY-8 program on the desktop. The Setup 
program will also automatically add a link to the HY8 program that can be accessed by clicking 
on Start, selecting Programs, and looking under the HY-8 folder until encountering the HY8 
program icon.  

Users with some experience with Windows may create additional shortcuts from here or by 
selecting the HY8.exe file found within the the C:\Program Files\FHWA\HY-8 folder.  

After Installation, a user is ready to run the HY-8 program (there should be no need to Restart 
the computer).  
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Windows & DOS Versions: Changes and Additions 
An important objective of the conversion of the HY-8 program to a Windows platform was 
maintaining the basic philosophy and simplicity of model input and operation. Additionally, a 
project development goal was to provide some backward compatibility in reading the existing 
input files (.INP).  

While FHWA and the development team feels these goals and objectives have been largely 
achieved, there were obviously some things that FHWA wanted to change and add in order to 
take advantage of the more modern Windows operating system. This section outlines these 
changes and new features and will serve as a road map to users who have long used the DOS 
version of HY-8.  

The Project File Approach 
The new version of HY-8 differs from earlier DOS based version in adopting a Project File 
approach. These project files are implemented into the Project Explorer – allowing quick 
selection and application of a specific culvert system2. As described below, the addition of this 
approach adds utility in (1) organizing and applying culvert systems within multiple drainage 
crossings and (2) during analyses of different design configurations and materials.  

Multiple Drainage Crossings 
The DOS version of HY-8 only allowed analysis or design of a single drainage crossing. While 
the user could define multiple culverts and barrels (systems) at this crossing, if an overall 
roadway project included many such crossing sites, each would need to be separated into a 
different input file.  

This led to the proliferation of many separate culvert input files associated with a single roadway 
project. Some practitioners described their confusion in distinguishing which culvert file was 
associated with which drainage crossing within a project.  

In the new version of HY-8, any number of crossings can be defined within the project file. 
Users now have the option of performing an analysis on several crossings and grouping them 
together. A new mapping feature (described below) helps the user to create a map identifying 
each crossing that can be included in their report.  

Of course, the Windows version retains older version’s ability to consider only a single drainage 
crossing. This single crossing can also still consist of multiple culvert systems (e.g., three 
circular barrels at one invert [system 1] and a box culvert at another invert [system 2] at the same 
roadway crossing).  

                                                 
2 As in prior versions of HY-8, a culvert system is considered as a collection of culverts, having the same type, 
material, inlet, dimension, and layout (invert elevations, length) characteristics.  So a single barrel corrugated metal 
pipe or a box culvert with cell barrels (cells) would be considered a system, whereas, if a crossing had both a 
circular HDPE AND a pipe arch, these would be considered two systems. A potential reason for multiple culvert 
systems at a crossing would be to allow “critter crossings” in one system and normal discharge through the other 
system.   
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Design Alternatives 
The new version of HY-8 also provides an improved means to consider separate design 
alternatives of the same crossing within the same project file. In the DOS version of HY-8, a user 
would either have to load them as separate files, or make the incremental changes and reevaluate 
a single file.  

The new version of HY-8 provides the user the option of “copying” a culvert and associated 
crossing information. With this “duplicate crossing” the user can make any change(s) they wish 
to evaluate. The project explorer then makes it easy to toggle back and forth between the 
alternative crossing designs.  

File Conventions 
The Windows version of HY-8 saves these Project Files using a “.HY8” extension. Unlike the 
DOS version of HY-8, the new version allows any file name format and length allowed by 
Windows. While HY-8 can read in older version .INP files, to protect this new utility and format, 
files can only be saved using this new format (and using the new “.HY8” files extension).  

Order of Input 
The DOS version of HY-8 presented the input as a series of linear, sequential input screens. The 
order always began with the discharge, followed by the culvert information, followed by the 
tailwater data, and ended with the roadway information.  

In the Windows version of HY-8, a single input screen presents all of the input necessary to 
analyze a single crossing.  

However, there are some important subtleties - the grouping of the information has been 
organized into “crossing” information and the “culvert” information. The discharge, tailwater, 
and roadway data are unique to the crossing while the culvert shape, inlet conditions, and site 
data define a culvert within the crossing.  

This grouping, and therefore subsequent tabbing through the main input screen, does not follow 
the same linear progression of input as the DOS versions of HY-8.  

Execution of SINGLE and BALANCE 
The DOS version of HY-8 contained separate analysis functions for computing a culvert 
performance rating curve (SINGLE module), and a roadway overtopping analysis (BALANCE 
module) that included the effects of all culvert systems within a crossing.  

When running this SINGLE module, DOS versions of HY-8 assumed that overtopping was not 
possible even though roadway data had been defined. Additionally, in the case were there were 
multiple culvert systems at the same crossing (e.g., a circular culvert and box culvert relatively 
side-by-side), the old SINGLE approach provided the performance curve of one of the systems 
(i.e., circular) assuming that the other system (i.e., box) was not present. One result was users 
potentially incorrectly applying SINGLE derived performance curve results.  

The Windows version of HY-8 performs all culvert analysis considering hydraulic effects of all 
culvert systems in the crossing as well as roadway overtopping. This means that when you view 
the performance table (or plot) for a given culvert within the crossing you are seeing the 
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performance within the context of any other culverts and overtopping of the roadway for the 
crossing and not just as an isolated culvert.  

If there is only a single culvert system and the roadway is high enough that overtopping does not 
occur, the performance curve of the old and new versions match.  

Front View 
The Windows version of HY-8 contains an option for displaying the front (upstream) view 
(elevations) of the culvert and roadway at the crossing. From a culvert hydraulics and numerical 
modeling perspective, computations do not need to consider the lateral placement of culverts 
within a crossing. Only the elevation relationships between the channel, roadway and other 
culverts are important.  

The information requested in the DOS version HY-8 input screens and input files (.INP) 
reflected this simpler approach. This led to challenges in viewing and plotting these features 
within the front view area of the updated program.  

Roadway Lateral Stationing 
To view the (scaled) relationship between the roadway and culvert system in the front view, HY-
8 will prompt the user to enter the lateral stationing of the culvert(s) vis-à-vis the roadway.  

One reason for requesting this additional value is while irregular shaped roadway sections in 
HY-8 have always prompted for lateral stations and elevations, the constant elevation option 
only prompted for a roadway length. This lack of stationing made visual presentation of the 
culvert location vis-à-vis the roadway problematic3.   

In order to allow for the possibility of defining actual stationing along a roadway, the Windows 
version of HY-8 includes a beginning station as well as the length for constant roadway profiles. 
The default beginning roadway station ordinate is zero and can be left as zero if actual stationing 
is not known (or not important).  

Lateral stations are defined from the beginning (left, facing downstream) side of the roadway and 
elevations taken from the upstream invert elevation parameter.  

Note on Culvert Barrel plots 
To allow backward compatibility with DOS version input files, the new version does not 
currently plot more than one barrel of a particular system. So while the program plots multiple 
systems at a crossing, the number of barrels within each system is not plotted. This multi-barrel 
plotting capability will be added in a subsequent upgrade.  

Note on Channel Cross Section plots  
As the front view represents the upstream view and because there is no cross section defined for 
the upstream end of the culvert, no channel cross section is plotted for the front view (the new 
version of the HY-8 program does plot the downstream channel cross section in a different 
portion of the program).  
                                                 
3 Conceivably, the old DOS version of HY-8 could have used differing stationing values between culvert centerline, 
channel station, and roadway values without any loss of hydraulic accuracy. This confused some practitioners.  
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The reason for this approach is that in culvert hydraulic practice assumes steady flow, associated 
with some design frequency. An upstream channel cross section is only needed when considering 
storage for inflow hydrograph routing. Requiring a user to add these upstream coordinates for a 
simple culvert layout and this steady flow assumption overly complicates the data requirements 
and the input process.  

Even approaches as simple as projecting the downstream channel along the culvert barrel to the 
upstream invert were rejected as this assumed a certain positioning of the channel and culvert 
barrel, as well as assumptions of roadway, barrel, and channel skew.   

Background Map 
Because multiple crossings can be defined within a single HY-8 project there is an option to 
create a background map. This map is only a picture and can be defined from any bitmap (.bmp) 
file. If you are connected to the internet you may search for a roadway or aerial view map online 
and save the result as your background map. You may also screen capture any image (i.e. a CAD 
drawing) and save that image as a bitmap (.bmp) file to import and use for your map as well. The 
map is only used for reference purposes and it or locations defined for culverts have no bearing 
on any calculations. Currently the map is sent to the report document, but you can cut and paste 
it into the file by capturing it from the screen.  

Report Generation 
The DOS version of HY-8 generated a comprehensive table that could be sent to a text file. 
However the old version lacked the ability to include graphs and take advantage of formatting in 
modern word processing programs 

The Windows version of HY-8 includes Report Generation tools that are customizable, allow 
many options for plots, and are saved in rich text format (RTF) or portable document format 
(PDF). The primary target for the report is an MS-Word document; however, an rtf format is 
readable by most Windows-based word processing programs.  

Known Issues 
A few issues related to Report Generation exist with this initial version. These will be corrected 
in future releases. These issues stem from a problem of placing tables and graphs within 
document text. In this initial version, each time a table or graph is written to the report, the report 
starts a new page. This can make reports longer (wasting paper).  

This is because of a limitation in the report generation library routines that do not allow tables 
and graphs to be “docked” in line with text. When trying to condense a report, these tables and 
plots may cover the text.  

Workaround 
After exporting a report you can manually dock tables in MS Word by selecting the table frame 
and then right-clicking on the upper left frame border and choosing the Format Frame option. In 
this screen select the “Remove Frame” button.  

For graphs you will select the graphic and right-click inside choosing the Format Picture option. 
In this screen choose the Layout tab and then the “In Line with Text” option.  
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Once these options are set for tables and graphs new page/sections can be deleted and the tables 
and graphs placed continuously. It is FHWAs intention to correct this limitation within the 
library functions used for report generation soon.  

 

Known HY-8 Issues 
A few issues continue to exist in HY-8, most of which are carried over as limitations from the 
DOS version. The following is a list of these issues: 

1. HY-8 does not attempt to show the location of a hydraulic jump in the culvert profile.  

2. If more than one flow type exists for the culvert profile, HY-8 does not attempt to show 
multiple profiles, but only that of the design discharge.  

3. NOTE: The user should be aware that when the tailwater elevation exceeds the elevation 
of the top of the culvert outlet, HY-8 assumes that the barrel flows full at the outlet and 
reports an outlet velocity corresponding to full flow. A more detailed description of this 
limitation is given in the Help document under the limitations topic. 

4. At this time, the new version of HY-8 does not support several culvert types, such as 
CONSPAN or HDPE plastic. FHWA intends to add these culvert types in the next 
upgrade.  

5. The new version of HY-8 does not support partially buried culverts or culverts with 
natural stream bottoms. However, as with the old version, the user may define a user 
supplied shape that includes different roughness for the sides/top and bottom.  

6. The new version of HY-8 does not support culverts with multiple slopes (broken back) 
and adverse slopes. These are being added in the next phase of this effort.  

7. The report functionality in HY-8 will improved to support additional file formats and 
additional options. 
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HY-8 Quick Start Tutorial 
This tutorial shows how to setup a single culvert in HY-8. The tutorial also shows how to view 
all the results of the culvert analysis. It is meant to be an introduction to using HY-8 for culvert 
analysis and is by no means a comprehensive reference to all the capabilities of HY-8. A more 
complete list of HY-8’s capabilities is contained in the HY-8 help file. 

Starting a Project 
1. Startup HY-8. The following window will appear: 
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2. Select Continue to add a new culvert crossing. 

 
 

Entering Project Data 
3. Enter the following into the “Discharge Data” section of the Crossing Data window: 
Minimum Flow 0.0 cfs 

Design Flow 400.0 cfs 

Maximum Flow 500.0 cfs 

 

4. Enter the following into the “Tailwater Data” section of the Crossing Data window: 
Channel Type Trapezoidal Channel 

Bottom Width 8.0 ft 

Side Slope (H:V) 2.0 (_:1) 

Channel Slope 0.04 ft/ft 

Manning’s n (channel) 0.032 

Channel Invert Elevation 89.2 ft 
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5. Select the “View” button to view the rating curve:  

 
 

6. Plot the Rating Curve if you wish, but when you are finished, close the plot window and 
choose “OK” in the Rating Curve window.  
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7. Enter the following into the “Roadway Data” section of the Crossing Data window: 
Roadway Profile Shape Constant Roadway Elevation 

First Roadway Station 0.0 ft 

Crest Length 100.0 ft 

Crest Elevation 110.0 ft 

Roadway Surface Paved 

Top Width 150.0 ft 

 

8. Enter the following into the “Culvert Data” section of the Crossing Data window: 
Name Example 6 

Shape Concrete Box 

Material Concrete 

Span 6.0 ft 

Rise 5.0 ft 

Manning’s n 0.012 

Inlet Type Conventional 

Inlet Edge Condition 1:1 Bevel Headwall 

Inlet Depression? No 

 

9. Enter the following into the “Site Data” section of the Crossing Data window: 
Site Data Input Option Culvert Invert Data 

Inlet Station 0.0 ft 

Inlet Elevation 90.0 ft 

Outlet Station 160.0 ft 

Outlet Elevation 89.2 ft 

Number of Barrels 1 
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Running an Analysis 
 

10. Select the Analyze Crossing button at the bottom of the Crossing Data window. (This 
runs the analysis, but does not save the information).  

 
 

11. Select the Crossing Rating Curve button.  
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12. A plot of the rating curve (Headwater Elevation vs. Discharge) will appear. After viewing 
this curve, close the plot window. 

 
 

13. Select the Culvert Summary Table option in the Display box. Any of the data displayed in 
any of the spreadsheets in this window can be selected, copied (using Ctrl+C), and pasted 
into any spreadsheet program. 
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14. Select the Culvert Performance Curve button.  

 
 

15. A plot of the performance curve (Inlet/Outlet control Headwater Elevation vs. Discharge) 
will appear. After viewing this curve, close the plot window.  
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16. Select the Water Surface Profiles option in the Display box. 

 
 

17. Select the 400 cfs profile (third from the bottom) and select the Selected Water Profile 
button.  
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18. A plot of the culvert profile (for the selected discharge of 400 cfs) will appear. After 
viewing this curve, close the plot window. 

 
 

19. Select the Close button on the Analysis window.  
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20. Select the “Example 6” culvert in the project explorer to show the culvert profile for the 
design discharge in the main window. Notice that the Culvert Profile icon is active.  
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Optional: Defining Front View 
Should the user wish to define the front view, they can do so at this (or any other time after 
entering crossing and culvert information). Recall that details regarding this option were 
discussed earlier in this document.  

 

FV-1 Select the Front View icon. A message will appear in the Main Window describing 
the requirement to define lateral culvert stations. Right click to do so.  

 
 

FV-2 A message will appear. Select “Define Roadway Culvert Stations”  
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FV-3 The Roadway Profile window appears. Notice that the roadway station data (0.00 ft 
and 100.00 ft) entered back in Step 7 is in the Window. Click on the Example 6 
Station field (currently the default of zero).  

 
 

FV-4 Enter the station of the centerline of the culvert system. For this example, let’s 
assume that this is at roadway station 50.0 feet (or halfway between the roadway 
section acting as a weir).  
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FV-5 Choose “OK” and the Main Window presents the Front View of the crossing.  

 

 
 

The user can “switch” between the Front View and Side View by selecting the appropriate icon. 
Notice that when the cursor is over a toolbar icon, a short help message in the lower left of the 
program window appears.  

Saving the Project File 
 

21. This may be a good time to Save the Project File. Select the Save As option from the File 
menu. When prompted, call the project file QS-Tutorial . The program will automatically 
add the .HY8 extension to this file.  
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Viewing Report 
 

22. Select the Create Report option from the Culvert menu.  
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23. The Report Generator window will appear:  

 
 

24. Select OK to export the data in the Included fields window to a report file. Additional 
data could be exported by selecting some or all items in the Available fields window and 
using the right arrow (>) to copy the fields from the available fields to the included fields 
window.  

 

25. After selecting OK, a rich text (RTF) file is exported and opened in Microsoft Word or 
whatever application is assigned to open RTF files (possibly WordPad if you do not have 
Microsoft Word installed). The report could have been exported in PDF format by 
selecting PDF for the File Format in the Report Generator window.  
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Optional: Editing a HY-8 Report 
The following steps will describe how to edit a RTF formatted HY-8 report in Word to condense 
the number of pages and make the document more readable (see discussion on Limitations, 
above). User experienced with other common word processing programs would apply analogous 
protocols.  

 

ED-1 If you have Microsoft Word, you should see the following view after exporting the 
report:   
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ED-2. Scroll down to the following page. You should see the following table:  

 

 
 

ED-3. Click within the table so the border appears around the table. Then right-click on the 
border of the table and select the Format Frame option as shown below:  
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ED-4. In the Frame window, select the Remove Frame button:  
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ED-5. Scroll down to the next page. You should see the following graph:  
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ED-6. Right-click on this graph and select the Format Picture option:  

 

 
ED-7. In the Format Picture window, select the Layout tab, select the In line with text 

option, and select OK.  
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ED-8. Continue editing all your tables and graphs as described in the steps above by locking 
the anchor on all the tables and setting the graphs so they are all in line with the text.   

 

ED-9.  Select the View | Normal menu item. Finish formatting your report document by 
removing all the unwanted page breaks and adding any additional information you 
wish to add to the report. After you are done editing, you can select the View | Print 
Layout menu item to see what the report will look like when it is printed.  

 

This concludes the Quick Start tutorial. Additional information may be found within the on-line 
Help associated with the HY-8 program. 
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Getting Help 
Beyond this and the HDS-5 document, the majority of the HY-8 documentation is self contained 
within the program. The functional use of the program is documented in the hyper-linked help 
file available from the Help menu or by selecting help buttons or icons ( ) from the graphical 
user interface. While the help file is organized to provide context-sensitive help, it can be printed 
out and organized into a hard copy manual.  

Additionally, the National Highway Institute provides courses on application of the HY-8 
software (135081 – Introduction to Hydraulic Highway Software” and other courses).  

While FHWA does not offer any user support (as described in the Terms and Conditions for 
downloading and using the program), comments and bug reports may be sent to:  

 CommentsOnHY8Version7.0@fhwa.dot.gov 

 

 


